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DoView - Simply Visualizing Outcomes. Software for
visual strategic plans, project models, outcomes
models, strategy maps, program logics, program
theories, results chains and simple cause-effect

models.

DoView can be downloaded from www.doview.com for a 14 day fully featured free trial.

For DoView Version 1.14 July 28, 2008  
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This DoView manual provides a general guide to using DoView. An electronic
version of this manual is available from within DoView: Help>Help. More
information on DoView from www.doview.com.
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1 Introduction
This help documentation is for DoView Version 1.1 It is available in a PDF version from the
DoView website www.doview.com/download.html and the electronic version is automatically
downloaded when you install DoView. The electronic version can be accessed by selecting 
He l p >He l p from the main menu at the top of the DoView screen.

Tip: You should also view the DoView Video Tours (select H elp>Tours from the main menu).

• If you are new to DoView, start with Getting started.
• Commands & features provides more specific detailed information about using DoView's

commands and features.
• Examples of use shows lots of different ways you can use DoView.
• Building outcomes models offers suggestions for how to structure and build high quality

outcomes models you and your stakeholders can use for a range of purposes; how to run a
DoView process; and using DoView in a meeting with a data projector.

• Installation & technical contains information on installation, specifications and technical
information on DoView file types.

Help Version 1.14 July 28, 2008

1.1 What is DoView?
DoView is an innovative piece of software which lets you quickly build outcomes models
(program logics, project models, strategy maps, program theories, theories of change, results
chains, simple cause-effect models, etc). 

The DoView Approach

The DoView approach is for you to have a comprehensive outcomes model which underpins your
project, program or organization. The same outcomes model can be used for strategic planning,
priority setting, monitoring, evaluation, research and development planning, contracting and other
aspects of organizational life. Using the same visualized outcomes model for some, or all, of
these purposes increases organizational, project or program alignment to achieving your
outcomes. Using the DoView approach you no longer have to rework the same material relating
to outcomes, strategy and performance management in different formats (e.g. a strategic plan in
one format, performance monitoring and evaluation in another, contracting specification in
another etc.).

Using the DoView approach means having software which helps you:

• Visualize even large outcomes models clearly and without clutter
• Store additional information relating to outcomes and the links between them
• Quickly navigate around your model
• Use your model in real-time in all meetings and discussions about strategy, priorities,

monitoring, evaluation, contracting etc.  

DoView is very simple to use in real-time and has been optimized for use on a data projector in a
medium-sized meeting. See the Using DoView in meetings Section. You can print your model as
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a PDF file (either letter/A4 or ledger/A3 size which can contain all of the diagrams (slices) in the
model and any information associated with the model.

For examples of use, see the Examples of Use Section. Uses include: program logics, project
outcomes, strategic planning, strategy maps, outcomes models, stakeholder plans and SWOT*
analyses.

*Strengths, Weaknesses, Opportunities and Threats analyses used in strategic planning.

1.2 Changes to Version 1.14
Always make sure that you have the most up-to-date version of DoView installed on your
computer (To find out which version of DoView you have, click on H elp>About in the main menu
at the top of the screen in DoView). Version 1.14 allows the user to create web page models of
the model they have open within a DoView file. When creating such a web page model, the
DoView user can choose to include in it the original DoView file (and/or a PDF of the DoView
file). This means that someone browsing the web page model on an intranet or the internet can, if
they wish, and if they have DoView installed on their computer, immediately download and edit a
copy of the original DoView file from which the web page version was created. Version 1.14 also
allows the user to insert external hyperlinks anywhere on a page (slice) within a DoView model. It
also allows an 'Extra Large' size for text objects.

If you have a registered earlier version of DoView you can update to Version 1.14 for free. Just 
uninstall your current version of DoView and then go to www.doview.com/download.html. Your
registration serial number will carry over so the new version will be automatically registered.

http://www.doview.com/download.html
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2 Getting started
This 'Getting Started' Section contains:

• DoView screen - shows you the main parts of the DoView screen.

• Try out a few things - provides some suggestions for trying out some DoView commands and
features.

2.1 DoView screen
The DoView screen includes the following:

The slice viewing area - the place in the middle of the screen where slices (diagrams) open one
at a time.

The toolbar - a set of commonly used tools running along the top of the screen. 

The slice list - down the right-hand side of the screen, it lists all of the slices (diagrams) in the
model you currently have open. 

The record table - runs along the bottom of the screen, each row contains additional information
associated with some of the objects you put on a DoView slice (diagram).
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2.2 Try out a few things
Try out the following five suggestions:
 

Now try the next four suggestions: 
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3 Commands & features
This 'Commands and Features' section provides detailed information on DoView's commands
and feature as follows:

Slices - 'diagrams' on which outcomes models are drawn in DoView. There are two sizes of these
compact and large.
Objects - of various types which you can put on slices (steps, text, groups, rule-lines, indicators,
questions, items).
Toolbar - runs along the top of the screen and includes commonly used commands.
Slice list - runs down right-hand side of the screen and provides a list of all the slices in your
model.
Record table - runs along the bottom of the screen and its rows are associated with some DoView
objects (steps, items etc.)
Steps - boxes which you put on slices which stand for outcomes, causes, effects, outputs,
activities etc.
Links - cause effect relationships between steps.
Links and drawn lines - using Link tool to draw line and arrows to show cause and effect
relationships between steps.
Views for links and lines - using the View menu to determine which type of links and drawn lines
and arrows are shown. 
Link lines - arranging - arranging line and arrow links on a slice by dragging their link boxes.
Clones - 'live copies' of a steps, groups, indicators, questions, items which are all amended if one
is amended. 
Hop-to - hyperlink which takes you ('hops' you) to another slice (makes it come up in the slice
viewing area).
Zoom - zoom to fit makes the slice being viewed fit within the area of the slice viewing area and
zoom to actual returns it to its actual size. 
Pan - lets you move a large slice around within the slice viewing area so you can view an area of
it.
Drill-down - right-click command from a step which creates a new slice containing a clone of the
step and sets relevant hop-tos.  
Text - text object is a piece of text which can be put on a slice and resized to small, medium or
large.
Groups - rectangular box drawn around other objects to visually group them.
Rule-line - dashed horizontal line running across a slice.
Indicators - indicator icon with a name for identifying ways of measuring steps. 
Questions - question icon identifying an evaluation, research or other questions about steps or
other objects on a slice.
Items - an item icon and a name identifying any other type of entity you want to put on a slice
(project, person, organization, thing etc.) 
Adjust - aligning and resizing objects (steps etc) on a slice.
Folders - heading in a slice list for organizing slices.
Rows - line in the record table associated with some DoView objects.
Fields - exist within a row for putting different types of information on the associated object
(name, description, notes, working notes).
Flag -  orange block of color on the left hand end of a row which you can turn on and off to draw
attention to the row and its associated  object. 
Rotate - right-click command from a step (or certain other objects) which turns the object on its
side.
Show details/fields - allows one field at a time from a row in the record table to be displayed on a
slice under its associated object.
Copying slices - copying slices for pasting within DoView or for pasting to outside software.
Slices, copying between models - copying and pasting slices between DoView files.
Model/file - the name for all of the slices in a DoView file.
Multiple instances of DoView - having more than one instance of DoView running at a time.
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Printing as PDF  - how to print slices and their record table information to a PDF file for emailing
or printing out a model. 
Import-Export - options for getting information in and out of DoView.
Web page models (creating) - how to create a web page model of all of the pages (slices) in a
DoView model for putting up on an intranet or the internet.
Web page models (using) - how to use a web page model when viewing it in a browser on an
intranet or the internet.
Hyperlinks (inserting) - how to insert hyperlinks onto a page (slice).

3.1 Pages (slices)
A slice is a 'diagram' or 'page' in DoView, they can be either compact or large (see below).

Slices are viewed in the slice viewing area. A DoView model (file) is made up of a number of
slices. All the slices in a DoView model are listed in the slice list. You move between slices (hop
between them) by: 1) clicking on the slice you want to see in the slice list; or 2) by clicking on a 
hop-to which has been set within a step.

A slice is create by clicking on New Slice in the Small Slice L ist Tool Bar at the bottom of the slice list
(on the right-hand side of the screen). A slice is deleted by clicking on Delete Slice. The Small Slice
List Tool Bar is shown below.

To rename, copy/paste or delete a slice do a right click on the slice name.

There are two slice sizes in DoView - Compact and Large. 

• Compact slices are the right size for viewing on a dataprojector
• Large slices can be used for printing to Ledger or A3 size paper

The default size for a DoView slice is compact. Compact slices are converted to large slices by
right clicking on a slice name and selecting Enlarge slice. You can not convert a large slice back to
a compact slice. Large slices are indicated by a larger slice color box (the small colored box on
the right-hand side of the slice name in the slice list). You can fit the contents of four compact
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slices onto a large slice. If you wish you can build your outcomes model with compact slices and
then clone them all onto one or more large slices for printing to ledger/A3 using Print as PDF. 

There are advantages in building your model in compact slices. For more information see the
Section on Why You Should Use Compact Slices.

For copying slices see Commands & Features Section: Copying slices.  For copying slices
between instances of DoView see Commands & Features Section: Slices, copying between
models.

3.2 Objects
A number of objects can be placed onto a DoView slice (diagram). These are:

Basic objects: (these can be put on a slice by right-clicking on a blank area of a slice and
selecting them from the right-click menu)

Step- Steps are boxes that can be put on a DoView slice. They can stand for causes at any levels
within an outcomes model (often just called outcomes). Steps have rows associated with them in
the record table.

Text- Text of any type can be put onto a DoView slice. It can be resized (on a right-mouse click)
to small, medium or large. Large text can be used for headings. Text does not have a row
associated with it in the record table.

Group - Groups are simply boxes that can be put around other objects to show that they are
visually grouped. Groups do not lock together any objects placed inside them.  Groups do have a
row associated with them in the record table.  

Rule line - Rule lines are simply dashed lines that run horizontally across a slice. They can be
used to visually mark levels between elements on a slice or for any other purpose. Rule lines do
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not have a row associated with them in the record table.

Hyperlink - Hyperlinks are any external hyperlinks out to any web address on an intranet or the
internet. The can be used to link to any material which is relevant to a part of a DoView slice.
They could even be used to link out to web page models of DoView files which have been put up
on an intranet or the internet.

Advanced objects: (these can be put on a slice by right-clicking on a blank area of a slice,
selecting Advanced and selecting the object  you want).

Indicator - Indicators consist of an indicator icon (small yellow icon) and an indicator name.
Indicators are used to place the name of measures of outcomes (steps) onto a slice. Indicators do
have a row associated with them in the record table.

Question - Questions consist of a question icon (small green circle with a question mark in the
middle) and a question name. Questions are used to put questions onto a slice that may be
related to particular steps (outcomes). Questions can be used for any type of question you may
have about your model, but are often are used for evaluation and research questions. Questions
have a row associated with them in the record table. 

Item - Items consist of an item icon (small grey square) and a name. Items are generic objects
which can be used for a range of purposes, for instance, to stand for projects, people,
organization or things etc. Items have a row associated with them in the record table.

3.3 Toolbar
The toolbar runs along the top of the DoView screen. It contains commonly used commands. You
can use the toolbar to insert some objects (a step, link, group or text) onto a slice by clicking on
the object button (tool) and then clicking on any blank area of the slice viewing area, where you
want that object to appear. 
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Back - goes back one slice (as in a Browser).
Forward - goes forward one slice (as in a Browser).
Open - opens a model (file).
Save - saves any changes in the currently open model (file).
Step - inserts a step onto a slice (click on the tool, then move to where you want the step to go on
the slice and click again).
Link - inserts a link between steps onto a slice (click on the tool, then move over the step you
want to link from, click once and hold down your left mouse button while you drag the arrow which
appears over the step you want to link to, then let go of your mouse button). The link tool can be
in one of two modes, selected using the small black down arrow on the right-hand side of the Link
tool (see Links and Links and Drawn Lines)
Group - inserts a group box with space for a group title around objects on a slice (click on the
tool, then move to where you want to put the group on the slice, click again and drag the group
box out to the size you want it).
Text - inserts text onto a slice (click on the tool, then move to where you want the text to go on
the slice, click again).
Pan - lets you pan (move) around a large slice around so you can view it in the slice viewing area
. 
Zoom to Actual - lets you zoom a slice in the slice viewing area to see it in its actual size.
Zoom to Fit - lets you zoom out a slice in the slice viewing so that you can see all of it at once if
it is larger than the slice viewing area. This is particularly useful for large slices.
Undo - undoes your last command (will not undo all commands e.g. delete slice).
Redo - redoes your last command (will not redo all commands).
Show slice list - opens and closes the slice list. 
 
Version 1.02 and earlier of DoView included a Copy Slice tool in the tool bar, from version 1.03
onwards this has been replaced with the ability to copy with a Right-click>Copy when selecting a
slice name in the slice list).

3.4 Slice list
The slice list is part of the DoView screen, it runs down the right-hand side of the screen. It
contains a list of all of the slices (diagrams) in the DoView model (file) you are currently working
on.

Slices can be nested under other slices by dragging. Folders can be created in the slice list.
Folders are not slices themselves, but slices can also be nested under folders.

Slices and folders are created by using the small slice list tool bar at the bottom of the slice list.
Slices and folders are deleted using the Delete Slice command in this tool bar.

Slices have a name, an automatically allocated color represented by the small colored rectangle
to the right of the slice name in the slice list, and a sequential number on the right hand side. The
slice number changes as slices are dragged and rearranged in the slice list.

Slices can be copied and pasted within an instance of DoView and between instances of DoView.
See Commands & Features Section: Copying slices and Commands & Features Section: Slices,
copying between models. 

On the toolbar, clicking Show slice list opens and closes the slice list.
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Selecting a slice name or folder name in the Slice List and doing a Right-click>Copy will allow you
to copy and paste it within the current file, to another DoView file, or to outside software (such as
Word, Powerpoint or Outlook). See Section Commands & Features: Copying slices.

3.5 Record table
The record table runs along the bottom of the DoView screen. The top edge of the record table
can be dragged up to make the record table larger or dragged down to make it smaller.

Rows within the record table are associated with some of the objects that can be put onto a slice.
The rows allow additional information to be added about an object.

When you select an object that has an associated row, the row is highlighted in blue. The row can
be edited by: 1) double clicking on the row; or 2) on the associated object doing a Right-click>Edit
details. 

Rows contain fields where you can put additional information. These fields are: the object ID; its
type; flag; name; description; notes; and working notes. Rows can also be flagged. When flagged
an orange block of color appears over the row ID on the left hand end of the row. 

In the example below the rows associated with a number of objects can be seen. Notes have
been added for the Indicator 1. A description has been added for Group 1 and notes have been
added for Item 1. The row for Question 1 has been flagged (an orange box has appeared at the
left end of the row). Note that the icon for the object appears in the type field of the record table.
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3.6 Steps

Steps are boxes which are one of the several types of objects which can be put onto a DoView
slice. They can be used to stand for causes or effects (outcomes, outputs, activities, tasks, key
drivers etc) which are put at various levels within an outcomes model. 

A step is put on a slice by: 

• double clicking on any blank area of a slice, or  
• clicking on the Step tool in the toolbar and then clicking on the place on the slice where you

want the step to go, or
• going to a blank area of the slice and doing a Right-click>Step
• pushing A lt-1
• for rapid step entry, by selecting a step, holding down Ctrl and pushing one of the four arrow

keys. This will create a new step in the direction of the arrow key each time you push it, or
• copying an existing step (Right-click>Copy) and pasting it (going to a blank area of the slice and

doing a Right-click>Paste).  

Steps have rows associated with them in the record table as below:

A step can also be pasted as a clone - a 'live copy' with a shadow of the step down one side as
below (Right-click>Copy then Right-click>Paste as clone where you want it). Various aspects of a
steps other clones (if it has any) are updated whenever the step is updated. 

3.7 Links
Links can only be made between steps. Once a step is linked to another step, whenever you
select the step, special DoView link icons show any other steps it makes happen (causes) and
which steps it is the result of (effects). In addition, whenever you wish, you can have a line drawn
to also visually represent a link.  
Tip: You can not have a drawn line without also having an underlying link. However, you can
have an underlying link without having it also being represented by a drawn line. 

You should read the rest of this section for information on links and then read the Section on 
Links and Drawn Lines for information about how you can also represent links with drawn lines.  

Make links by either: 1) clicking on a step, left-mouse clicking on the small blue box in the middle
of the step, holding your mouse down, dragging it over a second step which you want to link to
and then releasing the mouse button when the is a result of (see screenshot below) icon appears
on the bottom edge of the second step; or 2) clicking on the link tool in the toolbar and following
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the rest of the instructions for 1 above.

Every time you select a step any links to or from it will be shown by the DoView link icons
appearing. The is a result of (effect) icon is an upside-down empty triangle in the middle of the
bottom edge of a step (it represents an inward arrow head) and the makes happen (causes) icon
consists of two small lines sticking out of the top edge of a step (it represents the base of an
arrow). 

The DoView link icon is only shown for one step at a time in DoView - when you click on a step
which is linked to any other step the link icons appear. This keeps diagrams uncluttered. 

However, you can, if you wish, also represent links with drawn lines (see the Section on Links and
Drawn Lines). This means that you can show the links between a number of steps on a slice. This
can be useful when printing out slices using print as PDF. In addition, when you print as PDF you
can select the option of including information from the record table, which will put a list of all
outcomes and their links at the end of the PDF.

Selecting a step, right clicking and selecting either This makes happen or This is a result of, will list all
of the steps in the model (no matter what slice they are on) to which the selected step is linked.

Tip: If you select a first step and move to another slice without unselecting it, any steps on the
new slice which are linked to the first step will show the appropriate link icon, even if the first step
is not cloned onto the second slice.

In the example step below Step 1 has been linked to Outcome 2 and Outcome 3 and so when
Step 1 is selected the is a result of link icon will appear on Outcome 2 and Outcome 3.
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The example below shows how you can make a link between steps on different slices. Here Step
1 from the slice above has been cloned  onto the slice below (Right-click>Copy go to the slice
below and do a Right-click>Paste as C lone). It has then been linked to Outcome 5 and Outcome 6. If
you wish you could then delete the clone of Step 1 on the slice below. The links would still
remain, and whenever you selected Step 1 on the slice above and moved to the slice below
(without unselecting Step 1) the is a result of link icon would appear in Outcome 5 and Outcome
6.

Storing additional information about links in the record table

Links have rows associated with them in the record table as in the screenshot below. You can
access the information in the row by either clicking on the row when you have selected the link on
a DoView page (slice) (the row for the link will be highlighted in blue), or by double  clicking on
the link itself. 
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Hyperlinking out to additional information a link 

You may want to hyperlink out to an external web address (URL) for further information about a
link. For instance, it may be a summary of evidence on a web page (either one someone else has
put up or one you have put up) which supports the existence of the link you have made. You can
put a hyperlink on the page (slice) which points out to the relevant web page.

3.8 Links and drawn lines
Where there are links between steps, you have the option of also drawing these as lines (lines
with arrows at their ends). 

For basic information on making links, read the Section on Links. For information on arranging
link lines see the Section on Link lines - arranging. 

Tip: Remember, you can not have a drawn line without also having an underlying link. However,
you can have an underlying link without also having it represented by a drawn line.

Tip: When working with drawn lines, you should first make sure that you are in the right viewing
mode. From the View menu select the Show links and drawn lines mode. This mode will show both
underlying links and any drawn lines. For further information see the Section on Views for Links
and Lines. 

To draw lines for links, select the Insert link , and draw line mode from the small black down-arrow
to the right of the Link tool on the tool bar.  

The Link tool icon changes between the icon for just Insert link without a drawn line and the icon
for Insert link , and draw line depending on which option has been selected as shown in the
screenshot below.
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Links are made by selecting the step you want to link from, left clicking on the small blue square
in the middle of the selected step and dragging your mouse out and over the step you want to link
to. For more information on making links see the Section on Links. 

If a link is made using the Insert link mode of the Link tool on the toolbar, a link only is inserted as
in in the left-hand side of the screenshot below. If a link is made using the Insert link , and draw line
mode, a link and a drawn line is inserted as in the right hand side of the screenshot below. 

                  

Right clicking on a line shows a menu as in the left-hand section of the screenshot below.
Selecting E rase L ine just gets rid of the link line, but does not delete the underlying link as shown
in the middle section of the screenshot. A line can also be quickly erased by re-dragging from the
blue box in the center of a selected step out and across the step to which it currently has a drawn
line. Selecting Delete L ine deletes both the underlying link and its drawn line as shown in the right
hand section of the screenshot.
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3.9 Views for links and lines
Three options are available for looking at links within DoView. These are selected from the View
menu at the top of the screen. 

For further information on making links see the Section on Links, for information on drawing link
lines see the Section on Links and Drawn Lines.

• Hide links view option does not let you see any link information (either DoView link icons or line
and arrow links) about links between steps on a slice.

• Show links view option only shows the underlying DoView link icons (these only appear when
you select a step which is linked to another step). You can view the links to and from any step
by clicking on the step.

• Show links and drawn lines view option shows both the underlying DoView link icons when you
click on a step and any drawn lines for those links. 

In the screenshot below, all of the yellow boxes are linked to the blue box at the top. The Hide
links view option has been selected from the View menu and no link information at all can be seen
regarding the steps on the slice. 
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In the screenshot below, the Show links view option has been selected from the View menu.
Because  the middle step is selected, the DoView link icon in the blue steps shows that the
middle yellow step is linked to it. The same would apply if you selected either of the other yellow
steps as they are also linked to the blue box at the top. 

In the screenshot below, the Show links and drawn lines view option has been selected from the
View menu. The link icon for the middle yellow box is shown as in the screenshot above, however
in this view option, all of the drawn lines for the links are also shown.

Tip: Remember that you can not have a drawn line without also having an underlying link, but
that you can have an underlying link without also having it represented by a drawn line. So in the
screenshot below, the drawn line for the link from the right hand yellow step has been erased
(using a right click on the line>E rase line). Because DoVew is in Show links and drawn lines view
option, you can see the drawn lines for the two yellow steps on the left and in the middle. In
addition, because the right yellow step is highlighted, you can see the link icon for the link
between the right-hand yellow step and the top blue step.
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3.10 Link lines - arranging
Link lines are drawn lines and arrows which show an underlying link exists. These lines are
arranged on a slice by dragging the highlight boxes (green and red) which appear when a drawn
line is selected. To move a link line you need to drag one of the highlight boxes, you cannot drag
the link line itself. DoView has some smart line arranging features which make arranging link lines
fast and easy. 

Lines and arrows are drawn by selecting the Insert Link, and Draw Line option from the small
back down-arrow on the  information about how to insert drawn lines to represent links between
steps on a slice see the Section on Links and Drawn Lines. In sum

Tip: When working with drawn lines, you should make sure that you are in the right viewing
mode. From the View menu select the Show links and drawn lines mode. For further information see
the Section on Views for Links and Lines. 

Dragging green highlight boxes
In the screenshot below, a drawn line representing a link between Step One and Step Two has
been selected (by clicking on the link line). Note the highlight boxes in green, these are used to
drag the line when rearranging it. The red highlight boxes are the connection points of the line to
the steps - these can be dragged to any position around the border of the steps. Note also that
the normal DoView link icons (an inverted V on the bottom border of Step Two and two small
lines sticking up from the top border of Step One also always appear when you select a link line).
The horizontal segment can be dragged up and down the screen by holding down a left-mouse
click and dragging either of the green boxes up or down.   

Dragging red connection point highlight boxes
In the screenshot below, the red connection point has been dragged out to the left-hand side of
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the border around Step One (dragging using a left-mouse click). When this happens, an
additional segment is automatically put into the line so that it now has three green highlight boxes
(rather than just the two shown in the screenshot above).

Adding and removing segments
In the screenshot below, an further segment has been added using a right-click on the link line
and selecting Add segment This new segment is close in towards the left hand side of Step One.
Note that there are now four green highlight boxes. You can add as many extra segments as you
like to make complex link line arrangements.  

Straight line
To make a straight line, simply remove all segments apart from one (right-mouse click on the link
line and select Remove segment).This has been done in the screenshot below. 
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'Clamping' a segment to the top of a step
The screenshot below shows 'Clamping'. When a link line is first drawn, the horizontal segment
'clamps' to the top of the step from which it is drawn. This makes it much faster to move steps
around without having to separately adjust the spacing of the link line segment immediately
above them. In the left-hand section of the screenshot below, the horizontal segment of the link
line is locked in position just above Step One. If you, for instance, drag Step One down the
screen, the 'clamped' horizontal link line segment will move together with Step One down the
screen and remain in the same clamped position just above the top of Step One. 

To 'Unclamp' the segment, just drag one of the green highlight boxes up and away a little from
Step One. From then on, if you move Step One up or down the screen, the horizontal segment of
the link line will remain where it is and not move with Step One. The result of this is shown in the
screenshot below. If you reposition the horizontal segment back close to the top of Step One (or if
you drag it close to the bottom of Step Two) it will automatically reclamp. 
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Aligning link lines 
The best way of aligning link lines where a number of steps linking to a higher step is to insert the
steps you want (double click on a white space on a slice),  draw the link lines you want (see
Section on Links and Drawn Lines) and then just use the adjust command (select all the steps you
want to adjust, right click on the one which is at the right level and select Adjust>A light top).

This will result in the alignment of the link lines shown in the screenshot below.
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3.11 Clones
A clone is a 'live copy' of certain objects which duplicates aspects of the object (its name,
associated row in the record table, and links if it is a step). Amending these aspects of a clone
amends them for all other clones of the particular object.

Clones are made by copying an object (Right-click>Copy) and pasting it as a clone (on a blank
area of a slice Right-click>Paste as C lone).  Now the original object and the clone copy are both
clones - so any changes made to the name, record or links of either of them, will automatically be
applied to both of them. 

Clones can be made for the following objects:  steps, groups, indicators, questions and items.

Clones are indicated by a shadow down one side of the clone. In the screenshot below the clone
objects all have shadows down one side.

Tip: Clones let you build 'non-siloed' outcomes models since the same step (outcome) can
appear on more than one slice within a model.. 

Tip: To link Step A which is located on a first slice and Step B which is located on a second slice,
copy Step A and paste it as a clone Step A onto the second slice on which Step B is located. Link
Step A to Step B, and then if you wish, delete the clone of Step A from the second slice. The link
between the two steps will remain in existence. If you select Step A on the first slice and then go
to the second slice within unselecting Step A, you will see the link icon for the link between Step
A and Step B light up on Step B.
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3.12 Hop-to
A hop-to is a small colored triangle in the bottom right-hand corner of a step. It works just like a
hyperlink in a browser. Clicking on a hop-to will move you ('hop you') to the slice to which the
hop-to for that step has been set.The color of the hop-to is the same as the color of the slice it
hops-to (the slice color is the color of the small colored rectangle on the left of a slice name in
the slice list).

To set a hop-to for a step: Right click>Set hop-to slice, now select the slice you want to be able to
hop-to, from the list of slices you are presented with. If there are clones of the step, the slices on
which these appear will be listed first.

3.13 Zoom
Zoom is accessed from two zoom tools on the toolbar.

Zoom to Actual
Zoom to Actual shows a slice at its actual size. All of a compact slice can be seen in the slice
viewing area if the slice list is not shown and the top of the record-table is dragged down the
screen sufficiently. Only part of a large slice can be seen in the slice viewing area as it is larger
than the viewing area. You can move around a large slice when zoomed to actual size by using
the sliders at the right-hand edge and the bottom of the slice viewing area, or by using the Pan
tool on the tool bar.

Zoom to Fit
Zoom to F it will fit all of a slice into whatever space is available in the slice viewing area. Large
slices will be zoomed out more than compact slices. In Zoom to Fit mode you can still make links
in the normal way  and move objects around on a slice.
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3.14 Pan
The Pan tool is selected by using the Pan tool on the toolbar.

Pan lets you move a large slice around when it is viewed within a smaller slice viewing area so
that you can  see the area of the slice you want to see. 

3.15 Drill-down
In DoView you can 'drill-down' beneath a step to another slice on which you can put steps setting
out more detail.

To drill-down beneath a step, Right-click>Drill down to new slice. This will create a new slice (you will
be able to see it appear in the slice list). The new slice will have the same name as the step you
created it from (so in the example below the new slice would be called 'Step 1'. The old and the
new slice will now both contain clones of the step (Step 1 in the case below) you started from. In
the bottom right-hand corner of both clones the hop-to (small colored triangle) will be set so that if
you click on it it will open the slice that  has the other clone on it in the slice viewing area.
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3.16 Text
Text of any type can be put onto a DoView slice. It can be resized (Right-click>Change Size) to small
, medium or large. Large text can be used for headings. 

Text is put on a slice by: 

• clicking on the text tool in the toolbar and clicking on the spot on the slice where you want the
text; or 

• by going to a blank area of a slice and doing a Right-click>T ext; or 
• by pushing A lt-3. 
• by copying existing text (Right-click>Copy) and pasting it (go to a blank area of a slice and do a

Right-click>Paste). 

Text objects do NOT have rows associated with them in the record table. Text objects CANNOT
be cloned.
. 

3.17 Groups
Groups consist of a rectangular box drawn around other objects. They simply allow you to visually
group other objects. 

Groups are put on a slice by:

• going to a blank area of a slice and doing a Right-click>G roup; or 
• pushing A lt-2; or
• by copying an existing group (Right-click>Copy) and pasting it (going to a blank area of a slice

and doing a Right-click>Paste).

Groups have rows associated with them in the record table as shown below:

An group can also be pasted as a clone - a 'live copy' with a shadow of the indicator icon down
one side as below (Right-click>Copy, go  to where you want the clone and do a Right-click>Paste as
Clone. Various aspects of a group's other clones (if it has any) are updated whenever the cloned
group is updated. 
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3.18 Rule-line
Rule lines are simply dashed lines which run horizontally across a slice. They can be used to
visually mark levels between elements on a slice or for any other purpose.

 Rule lines are put on a slice by:
 
• going to a blank area of a slice and doing a Right-click>Rule line and dragging the end of the line

out as long as you want it; or 
• pushing A lt-4 and then dragging the end of the line out as long as you want it. 
• by copying an existing rule-line (Right-click>Copy) and pasting it (go to a blank area of a slice

and do a Right-click>Paste).

Rule lines do NOT have rows associated with them in the record table. Rule lines CANNOT be
cloned.
. 

3.19 Indicators
Indicators consist of an indicator icon (small yellow icon) and an indicator name. Indicators
represent measures of how steps (outcomes) are changing.

Indicators are put on a slice by:

• going to a blank area of a slice and doing a Right-click>Advanced>Indicator; or, 
• pushing A lt-5. 
• by copying existing indicator (Right-click>Copy, go to where you want the indicator and do a

Right-click>Paste.

Indicators have rows associated with them in the record table.

An indicator can also be pasted as a clone - a 'live copy' with a shadow of the indicator icon down
one side as below. Right-click>Copy go to where you want the clone and do a Right-click>Paste as
Clone. Various aspects of an indicator's other clones (if it has any) are updated whenever an
indicator is updated.

Right-clicking on a selected or unselected indicator gives the following menu which allows you to
do things with the indicator.
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But, double clicking on a selected or unselected indicator selects the indicator name, right-
clicking when the indicator name is selected gives the following menu which allows you to cut and
 paste etc. the indicator name. The Input Method and Insert Unicode Control Characters options
are for use with different languages.

Indicators CANNOT be linked with themselves or with other objects, only steps can be linked and
only to themselves. Indicators can be visually associated with other objects by how close you
position them near to the other objects on a slice.  

3.20 Questions
Questions are used to put questions on a slice which may be related to particular steps
(outcomes). They are used for evaluation questions, research questions or other questions about
outcomes or other objects on a slice.

Questions are put on a slice by: 

• doing a Right-click>Advanced>Question on a blank area of a slice; or 
• pushing A lt-6. Questions can be used for any type of question you may have about you model,

but are often are used for evaluation and research questions. 
• by copying an existing question (Right-click>Copy, go to where you want the question and do a

Right-click>Paste).

Questions do have rows associated with them in the record table.
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A question can also be pasted as a clone - a 'live copy' with a shadow of the question icon down
one side as below. Right-click>Copy go to where you want the clone and do a Right-click>Paste as
Clone. Various aspects of a question's other clones (if it has any) are updated whenever a cloned
question is updated.

.

Questions CANNOT be linked with themselves or with other objects, only steps can be linked and
only to themselves. Questions can be visually associated with other objects by how close you
position them near to the other objects on a slice.  

3.21 Items
Items (the item icon with attached text) are one of the several types of objects which can be put
onto a DoView slice. Items can be used for any type of item you may want to put onto a model, e.
g. person, project, thing etc.

Items are put on a slice by: 

• going to a blank area of a slice and doing a Right-click>Advanced>Item; or 
• pushing A lt-6. 
• by copying existing item (Right-click>Copy, go to where you want the item and do a Right-

click>Paste.

Questions do have rows associated with them in the record table.

An item can also be pasted as a clone - a 'live copy' with a shadow of the item icon down one
side as below.  Right-click>Copy go to where you want the clone and do a Right-click>Paste as C lone.
Various aspects of an item's other clones (if it has any) are updated whenever an item is updated.

Items CANNOT be linked with themselves or with other objects, only steps can be linked and only
to themselves. Items can be visually associated with other objects by how close you position
them near to the other objects on a slice.  

3.22 Adjust
Steps, or other objects, can be aligned using the Adjust command. Select all the steps you want
to align, right-click on one of them and select the type of alignment you want - align top or align left
. In addition, Adjust can also be used to resize steps.  Select the steps you want to make the
same size, move to the step you want the other steps to be the same size as, do a Right-
click>Adjust>Same Size. 
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3.23 Folders
Folders are headings which can be put into the slice list. Slices can be nested under folders.
Folders are not slices so clicking on a folder will not change the slice  in the slice viewing area.

3.24 Rows
A row is a line in the record table at the bottom of the DoView screen which is associated with
selected objects - steps, groups, indicators, questions and items.

A set of rows in the record table is shown below. See the Record Table Section for more detail.
Rows can be flagged.
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3.25 Fields
Rows in the record table (which are associated with some DoView objects) have four fields -
name, description, notes and working notes. 

Entering information into the fields of rows in the record table is done by:

1. Selecting the object for which you want to add additional information.  This will highlight in
blue, the row in the record table associated with the object.

2. Double clicking on the highlighted row in the record table. An editing box will open which will
have four tabs, one for each of the fields in the row - name, description, notes, working notes.

3. Clicking on the tab of the field you want to enter information into.
4. Typing the information in.
5. Clicking Apply if you want to save the information in the middle of typing it in (for instance if it
is a lengthy piece of text).
6. Clicking O K  when you have finished entering the information.

An alternative way of accessing the associated row in the record table is to do a Right-click>Edit
Details on an object (step, link, indicator, question, item) with has a row associated with it in the
record table.

Fields can be displayed on a slice one at a time. See the Display Fields Section.

Tip: You can use the 'notes' field for formal notes about an object which you have completed and
which you may wish to display on a slice with the display fields option. You can then use the
'working notes' field for more informal notes to you and your colleagues about  byour thoughts, or
things you need to find out about the object etc.
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3.26 Flag
A flag is located on a row within the record table at the bottom of the DoView screen. Clicking on
the flag circle simply flags the row for your future reference. You may do this to remind yourself
that you have not yet finished putting information into the row or for any other purpose. 

In the screenshot below the row associated with Step B has been flagged by clicking on the small
circle in the Flag column. The fact that this row is flagged is shown by the block of orange color
over the row ID at the left end of the row.

3.27 Rotate
Some objects (steps, groups, text, indicators, questions, items) can be rotated.

To rotate an object:

• Right-click>Rotate>On a side.

To return an object to normal:

• Right-click>Rotate>L evel. 

The screenshot below shows text, steps and indicators which have been rotated.
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3.28 Show details/fields
The fields of selected objects which have rows associated with them in the record table can be
displayed directly on a slice. This is possible for indicators, questions and items. But not for steps
. 

This is done by:

• Right-click>Show Details and then selecting the details you want to show.

Note: The description, notes and working notes fields can only be displayed one at a time.

The screenshot below what happens when you Right-click>Show Details on the item called 'This is
an item'.

The screenshot below shows part of a slice illustrating the results of displaying different fields for
clones of the item 'This is an item'.



42 DoView Help

© 2007-2008 The Ideas Web Ltd

3.29 Copying slices
Up to Version 1.02 of DoView there was a Copy Slice button in the toolbar, from Version 1.03
onwards this has been replaced by the ability to copy slices using a right mouse click in the slice
list. This is used to: 1) copy slices within DoView; 2) copy and paste a slice into an outside piece
of software (Microsoft® Word, Powerpoint, Outlook® etc.) using Windows Clipboard for a single
slice, or Office Clipboard for multiple slices; or 3) copy and paste slices instances of DoView (see
the Commands and Features:  Slices, copying between models Section).

1. Copying slice(s) within an instance of DoView

1.1 A single slice which has no slices under it. Select the slice name you want to copy from
the slice list and Right-click>Copy. Go to the slice or folder  under which you want the slice to be
copied and Right-click>Paste. See screenshot below. Tip: if the entries in the slice list do not take
up all of the space in the slice list you can Right-click>Paste on the white space at the bottom. In
this case the slice will be pasted under the currently selected slice name. 

1.2 Slices or folders with one or more slices under them. Use the same method as 1.1 above
and all of the slices and folders beneath a slice or folder will be copied and pasted. Tip: if you just
want to copy a slice on its own which has other slices under it, you can either: 1) leave the slice
list, go onto the slice itself, select all its contents by dragging the mouse over it while holding
down the left mouse button, go Right-C lick>Copy, make a new slice (by using the New Slice tool in
the slice list) and then paste the contents onto that new slice (Right-click?Paste); or, 2) copy and
paste the slice and the slices below it using the method set out in above and then just delete the
additional copies of the slices which were under the slice you want copied.  

2. Pasting a single slice to external software using Windows Clipboard

Select the slice name you want to copy of the slice list and Right-click>Copy. Go to the other
software (Word, Powerpoint, Outlook® etc) and do a Right-click>Paste, Edit>Paste or Ctrl-V  to paste
an image of the slice into the other software.

Using Office Clipboard for pasting multiple slices into external software
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You can quickly get multiple slices out of DoView to put in other software using a feature
available in some versions of Microsoft® software. 

1. Go to Word, Powerpoint or Outlook and select Edit>Office C lipboard from the main menu. This
will open a window down the right-hand side of the application called 'Clipboard'. 

2. Click Clear A ll to get rid of anything currently in the clipboard. 
3. Return to DoView (the Alt-Tab shortcut will get you there fast) and move through all of the

slices you want to put into Word, Powerpoint or Outlook. Click on the slice name in the slice list
to get each slice to open in the slice viewing area and Right-Click>Copy. 

4. Return to Word, Powerpoint or Outlook (again you can use the Alt-Tab shortcut to get there
fast). You should now see all the slices you want in the clipboard window on the right hand side
of the software.

5. Click where you want the slices inserted in Word, Powerpoint or Outlook® and then click on the
image of the slice you want to insert in the Clipboard. You can rapidly place a number of slices
into Word, Powerpoint or Outlook in this way.

Tip: If you copy the slices in DoView in the reverse order to how you want them inserted into
Word, Powerpoint  or Outlook®, you will find that they will end up in Office Clipboard in the right
order for you to paste them into the other software in the correct sequence.

3.30 Slices, copying between models
To copy slice(s) between models (from Version 1.03 onwards):

1. Open the file you want to copy from (F ile> Open).
2. Open the file you want to paste to (F ile> Open).
You should now have two instances of DoView running (you can move between the instances by
clicking on each instance in turn in the Windows taskbar). 
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3. In the slice list, right-click on the slice you want to copy and select Copy. (Make sure you are
just getting the right-click menu shown below, not the right-click menu for editing the slice name).
4. Go to the instance of DoView which contains the file you want to paste the slice to.
5. In the slice list, right-click either on a slice name (if you want to paste the slice under it) or on
the white area in the slice list.
6. Click Paste. 

Tip: Copying a slice or folder which has other slices beneath it will copy all of the slices beneath
it. If you just want to copy a slice on its own which has other slices beneath it, you can either: 1)
leave the slice list, go onto the slice itself, select all its contents by dragging the mouse over it
while holding down the left mouse button and then using a right-click menu to select copy; or 2)
copy and paste the slice and the slices below it using the method set out in this section, but then
just delete the additional copies of the slices which were  beneath the slice you wanted to copy. 

3.31 Model/file
A DoView model is simply a DoView file. There are three DoView file types - the main file type
ends with the file extension .doview. See File Formats & XML Section for more information.

DoView models are opened using:

• the Open tool on the toolbar; or
• selecting F ile> Open from the main menu at the top of the screen; or
• Ctrl-O.

DoView models are saved using:

• the Save tool on the toolbar; or
• selecting F ile>Save from the main menu at the top of the screen; or
• Ctrl-S.

 A single DoView file contains all of the slices (diagrams) and related information about one or
more projects.
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3.32 Multiple instances of DoView
Every time you open a file within DoView a new instance of DoView starts. This lets you work on
more than one model at a time. It also lets you copy and paste slices between instances of
DoView (see Command & Features Section: Slices, copying between models.

A new instance of DoView can be opened by: 

• clicking on the Open tool on the toolbar; or
• selecting F ile> Open or F ile>New Model from the main F ile menu at the top of the screen.

.

3.33 Printing as PDF file
All slices in a model, or just a selection, can be printed to a PDF file along with the accompanying
information in the record table. You can send the PDF version of the model to others by email or
use it to print out the model slices and accompanying record table information.

Print as PDF
To print as a PDF select F ile>Print as PD F from the main menu at the top of the screen. 

Printing compact and large slices in the same PDF file
To print a file from DoView, you Print as PD F from the F ile menu within DoView and save the file
to your drive. Then you open the file you have saved in a normal PDF viewing program program
and print it from  that software. 

You can print compact and large slices (see Section on Slices for more information on compact
and large slices) to the same PDF using DoView. Then, when you open the PDF in your normal
PDF viewing software,  the following will happen when you print it: 

• If printing to letter or A4 sized paper - compact slices will be in normal sized print and large
slices will be shrunk down to fit onto the letter or A4 sized paper. At this size, only the step
names on large slices will be readable (not any text in small size, such as indicators).

• If printing to ledger or A3 sized paper - compact slices will be expanded to fill the ledger or A3
page and large slices will be in normal sized print. 

To print to ledger or A3 size, select print and then select the paper size from within whatever
software you are using to view the PDF. Then select the Fit to Margin option (this option will be
within whatever software you are viewing the PDF, you will not find this command inside
DoView).
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Print as PDF options within Doview
Select the DoView printing as PDF options you want from the following screen.

All the slices which you have selected to print as a PDF file will appear in the PDF file, one to a
page in landscape layout. To select more than one slice hold down Ctrl and to select a range of
slices hold down Shift. The PDF printing options are:

Include slice names - the name of the slice will be printed in the bottom left hand corner on each
page which contains a slice.  

Number pages - a page number will appear in the bottom right hand side of each PDF page. 

Include data table (record table) - information from the record table will be included at the end of the
PDF file. This will be set out in the following format: each step (only steps from the slices which
are being printed are included); any record table information for that step; information on links to
and from the step (under the headings This makes happen and This is the result of). If there is
any record table information associated with a link this is shown by there being a small
superscript number next to the initial symbol in the entry for that link (e.g. in the example below
of Music played at appropriate time). This reference number refers to the number for the link.
Those links which have information associated with them are listed at the end of the PDF file.

If there are additional objects on the slices which are being printed to PDF these will be listed  in
the order: indicators, questions and items.
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3.34 Import-Export
The following can be used for getting information out of DoView (and in some cases into
DoView):

•  Slices can be moved between instances of Doview by using copy and paste in the slice list
(see Section: Slices, copying between models). 

• All slices in a model can be transferred out of DoView by selecting each of them separately and
pasting them into external software such as Word, Powerpoint or Outlook® (see Section: 
Copying slices). 

• All of the slices in a model and all of the contents of the record-table can be printed to PDF
(see Section: Printing as PDF file). 

• All of the slices in a model can be turned into a web page model which can be put up on an
intranet or the internet (see Section: Web page model (creating).

• Text within objects (steps, text, indicators etc.) can be copied and pasted back and forth
between DoView and external software using a Right-mouse click.  

• A DoView file can be saved in XML format which can potentially be accessed by some other
types of software if it was explicitly set up to import the XML file produced by DoView. 

3.35 Web page models (creating)
All of the slices within a DoView file can be made into a web page model for putting up on an
intranet or the internet. Such web page models contain all of the pages (slices) from the model
from which they were created, their clickable hop-tos, and a list of pages (slices) for navigation
(called the Contents list in the web page model).  Web page models do not contain information
from the record-table, nor do they let those browsing them on an intranet or the internet click on
each step to see which steps it is linked to (by revealing the DoView link icons). However, if you
select a particular step within a DoView file (making its DoView link icons appear in any step it is
linked to) and then immediately create a web page model, the web page model will show all of
the DoView link icons for the selected step. 

When you create the web page version of a DoView model, you have the option of including the
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following: a T itle for the web page model; a logo of your own choosing; a copy of the original
DoView file you are creating the web page model from; and a PDF of the original DoView file you
are creating the web page model from. 

Tip: The web page model you create will include all of the pages (slices) within the DoView file
you are creating it from. Therefore if you do not want some of the pages (slices) to appear in your
web page model, save a special copy of your DoView file just for creating the web page model
and delete from it all of the pages (slices) you do NOT want to appear in your web page model.

To see what the web page version of the model looks like see Section: Web page models (using).

Create web page model

To create a web page model select F ile>C reate W eb Page Model from the main menu at the top of
the screen. 

The following dialog box will open and you can then put in the T itle of the web page model which
will appear along the top of the web page version of the model. 
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Including a logo in the web page model

You can include any logo of your choice in a web page model. It will appear in the top right-hand
corner of the web page version of the model  you create. First you need to choose the logo you
want by clicking on Choose Logo. This opens the dialog box below:

Clicking on Browse for Logo opens the dialog box shown below from which you can select the file
containing the logo image you want to include in the web page version of the model.

The selected logo file will be loaded into the DoView file and remain in the file from then on (you
can load a new logo at any stage). The dialog box below will open and you have the option of
putting in a web address. This web address is where someone browsing the web page model will
go if they click on the logo which will appear in the top right-hand corner of the web page version
of the model. 
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When you click O K  you will be returned to the dialog box shown below:

Including a copy of the original DoView file

If you want to, at this stage you can check the box next to Include a copy of this model's DoV iew file?
This means that in the final web page version of the model, the option shown below will appear
on the Options bar at the bottom of the web page version of the model. Someone browsing the
web page version of the model will be able to click on this and immediately download a copy of
the original DoView file from which you are about to create the web page version of the model.  

Caution: Before checking this option, you need to make sure that you are happy for
anyone to be able to download, use and edit a copy of the original file from which you are
creating the web page version of the model. Also you need to realise that this will give
anyone access to whatever you have written in the record-table in the original DoView file.
While the contents of the record-table do not appear in the actual web page version of the
model, if you give those browsing the web page version of the model the option of
downloading a copy of the original DoView file they will be able to see the contents of the
record-table when they open it up.

Including a PDF of the original DoView file
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If you want, at this stage you can check the box next to Include a PD F file of this model? This means
that in the final web page version of the model, the option shown below will appear on the
Options bar at the bottom of the web page version of the model. Someone browsing the web
page version of the model will be able to click on this and download a PDF of the DoView model.
This PDF will include all the pages (slices) in the web page model. The option to include the PDF
in the web page version of the model is so that someone browsing the web page version can
download the PDF if they want to print out all of the pages (slices) in the model. 

The options available for the PDF are the same as when using the Print as PDF command. When
the option to include the PDF file of the model is checked, the normal PDF options will appear at
the bottom of the dialog box as shown below:

Creating and saving the web page models

Once you have finished checking the options you want as outlined above, you click Save as...  A
normal file dialog box will open up for you to select the sub-directory on your local computer
where you want to save all of the files which will make up the web page model (these are the full
set of HTML and other files needed for the web page model).

Tip: the file name for the web page model should be as short as possible, all in lowercase and
without any spaces. This is so that it will be easy for people to type it into a browser when they
want to go to it on an intranet or the internet.  
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The full set of HTML and other files will appear in the subdirectory you have selected as a single
HTML file with the name you have given it (e.g. webpagemodel in this case) and two
subdirectories. The first sub-directory (e.g. webpagemodels-attachments) contains the original
DoView file and a PDF file of the web page model if these options were selected when the model
was created as outlined above. The second sub-directory c(e.g. webpagemodel-slices) contains
all of the pages (slices) which are included in the web page model. An example of the file and two
sub-directories which are created are shown below:

Publishing a web page model to an intranet or the internet

All that is now needed to publish the web page model onto an intranet or the internet is to transfer
the file and two sub-directories which have just been created to the appropriate sub-directories on
the relevant intranet or the internet. You can ask the the Webmaster of the intranet or internet
site where you want to put the web page model to do this for you. Usually the Webmaster will
want you to zip the sub-directory where you have just saved the files which make up the web
page model and email it to the Webmaster so they can unzip it and place it onto the relevant sub-
directory on the intranet or at an internet site. Alternatively, if you have access to an intranet or
internet sit via FTP, you can just directly copy the file and two sub-directories you have just
created which contain the web page model onto the appropriate sub-directory on the intranet or
the internet. Using FTP like this can be done directly from within File Explorer on Windows or by
using any FTP software (like Cute FTP). You should just ask your Webmaster to set you up in
this way to do this very simple operation to publish your web page model. Publishing your web
page model in this way should be no more complicated that copying files between subdirectories
on your own local computer.
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For more information on what the final web page version of the model will look like and how to
use it, see Web page models (using).

3.36 Web page models (using)
A web page model of a DoView file is created with the command F ile>C reate W eb Page Model. More
information here. 

A web page model contains all of the pages (slices) from the model from which it was created,
their clickable hop-tos, and the list of pages (slices) for navigation.  Web page models do not
contain information from the record-table, nor do they let those browsing a model on an intranet
or the internet click on each step to see which steps they are linked to (by showing the DoView
link icons). However, if you select a  particular step within a DoView file (making its DoView link
icons appear) and then immediately create a web page model, the web page model will have
visible all of the DoView link icons in the steps which are linked to the selected step. 

When the web page version of the model is created, the user has the option of including the
following: a Title for the web page model; a logo of their own choosing; a copy of the original
DoView file they are creating the web page model from; and a PDF of the original DoView file
they are creating the web page model from. 

Overall look of a web page model

A web page model looks like the one below. Once it is put up on an intranet or the internet, it can
be viewed in any internet browser on an intranet or the internet. If the right-hand side of the web
page model is hidden by the Contents list - it can be turned off by clicking Hide Contents. If the
bottom of the web page model is hidden by the Options bar - it can be turned off by clicking Hide
Options. 
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General navigation in a web page model 

Someone browsing a web page model on an intranet or the internet can navigate around the webpage model as shown in the
screenshot below. 

 

'Hop-tos' within a web page model and external hyperlinks out to external web addresses

There are two types of hyperlinks which can appear on a DoView page (slice). The first is an
external hyperlink out to any web address on an intranet or the internet. The second is a 'hop-to'
which takes the viewer to another page (slice) within the same web page model. The icons  for
these are shown in the screenshot below. 
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Downloading DoView and PDF files from within a web page model 

A novel aspect of DoView web page models is that the original DoView file which created the web
page model can be downloaded from the Options bar at the bottom of the screen. In addition, a
PDF of the web page model can be downloaded for those who want to print out all of the pages
(slices) in the web page model. The user who created the web page model has the option of
including these two options in the web page model. For more on creating a web page model see 
Section: Web page models (creating). The web page model downloads options are shown in the
screenshot below.
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3.37 Hyperlinks (inserting)
External hyperlinks are one of the several types of objects which can be put onto a DoView page
(slice). External hyperlinks can be used to link out to any other web page on an intranet or the
internet. 

Hyperlinks are put on a slice by: 

• going to a blank area of a slice and doing a Right-click>Hyper link; or 
• pushing A lt-5. 
• by copying an existing hyperlink (Right-click>Copy), going to where you want the item to be and

doing a Right-click>Paste.

The dialog box below appears when a hyperlink is first created. Put the web address into the line
at the top and the name of the hyperlink (which you want to appear on the page (slice)) on the
second line.

dean b
Double clicking on a hyperlink on a DoView page (slice) will take you out to the external web
address (URL) it is linked to. If no web address has been specified for a hyperlink when you
double click on it, nothing will happen.

Right-clicking on a selected or unselected hyperlink gives the following menu which allows you to
do things with the hyperlink.

Edit Details is used for editing the address and name of the hyperlink. In contrast to other objects
in DoView (text, indicators, evaluation questions, items), double clicking on a hyperlink does not
allow you to edit it directly (because it takes you out to the external web address). 
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4 Examples of use
This section provides examples of the ways in which DoView can be used as follows:

You should also see the DoView Video Tour Quick Examples Tour (select H elp>Tours from the
main menu).

• Project plan
• Outcomes model with line and arrow links
• Strategic plan
• Program logic
• Strategy map
• Outcomes model
• Evaluation & monitoring plan
• Stakeholder plan
• SWOT analysis

4.1 Project Model
DoView is outcomes visualization software rather than specialized project planning software. It
can be used to quickly overview the high level outcomes for projects large or small. (However, if
you are building a skyscraper or supertanker then use large scale project planning like Microsoft®
Project for your detailed planning). It can also be used for project evaluation. (See the evaluation
and monitoring plan section).

To build a simple project model:

1. Identify the high level outcome or outcomes you want the project to achieve and enter them
as steps along the top of a DoView slice.

2. Progressively put in the lower level tasks which need to be done to make higher level
outcomes happen. If you need more than one slice, drill-down to lower level slices with more
detail about particular steps. 

3. Make links between lower level steps and the steps above them which they make happen if it
is not clear which steps lead to which.

In a large project, use the model you have build in 1-3 above to discuss the project outcomes and
mechanisms with stakeholders and change the model as necessary. Use the model to report back
progress from time to time. See the Using DoView in Meetings section for tips on how to run the
process.

If you want you can continue to build you model looking at who is going to do what by:

4. Entering organizations (or workers for small projects) as steps.
5. Linking organizations (or workers) with the steps they are going to be responsible for doing.

This is particularly useful for joint-ventures and collaborations where everyone needs to be
clear on high-level outcomes and also on which organization is going to do what.

Tip: DoView is flexible and will allow more than one organization to contribute to (link to) any one
step.

The first example below is a very simple example of a one slice project model - for organizing a
trade convention. Note that John is responsible for two items - 'Preparing conference materials'



59Examples of use

© 2007-2008 The Ideas Web Ltd

and 'Sending out conference pack'. The step representing John has been linked to these two
tasks and whenever you click on John, the link icons will appear on the two tasks. Note that there
is a hop-to in the step called 'Collect registration'. Clicking on this would take you down to another
slice which sets out details about the steps needed in the registration process. Project workers (or
organizations for collaborations) can be linked to tasks on other slices by cloning the step
representing the worker (or organization) onto the slice where the task appears, making a link to
the task and then, if you wish, deleting the clone representing the project worker (or
organization). 

Tip: If you select the step representing a project worker (or organization) on one slice and move
to another slice without unselecting it, any steps on the new slice which are linked to the project
worker (or organization) will show the appropriate link icon, even if the step representing the
project worker (or organization) is not cloned onto the second slice. You can use this to build
larger project models where project workers (organization) are responsible for tasks which appear
on a number of other slices. 

The second example slice below is of using DoView to model a collaborative project. The
outcomes that Building Retailers will be aiming to achieve have their link icons showing because
the Building Retailers step has been selected.
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4.2 Outcomes model with line and arrow links
From Version 1.1 DoView lets you use lines and arrows to make links. This is an example of an
outcomes model which uses line and arrow links. (See the Section on Links and Drawn Lines and
that for Views for  Links and Lines more information).
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4.3 Strategic planning
DoView can be used for high level strategic planning. Stakeholders often find it easier to think
about their high level objectives when they are visuallized as outcomes in a DoView model. 
DoView can also be used for specific tasks within strategic planning - stakeholder planning and S
WOT* analysis. The steps for drawing a strategic plan in DoView are as follows:

Draw an outcomes model

1. Identify the highest-level outcomes for your organization. Enter them into DoView as steps. 
2. Identify lower-level steps needed to achieve these high-level outcomes. 
3. Continue to drill down as far as is appropriate for your discussion. Drill down detail onto other

slices. 
4. Get agreement of your internal and (as appropriate) external stakeholders to the outcomes
model.

The top levels of your outcomes model make up your vision and mission. You may want to write
these out separately as in a traditional vision and mission statements, or you might be happy with
the way they are visualized in your DoView model without having to have a separate vision and
mission statement. If you want to simply use the DoView approach, print the high level slices out
using print as PDF and use them as your high level  vision and mission statement (you can put
them up on the wall as you would a vision and mission statement if you like). 

Priority setting during strategic planning

5. Get agreement of your internal and (as appropriate) external stakeholders for the priorities for
your organization in the next planning period. You can mark these on your DoView model by
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making priority steps different colors (e.g. using the three different shades of blue to show
priority) or you can just put numbers (1,2,3 priority) or letters (A,B,C priority) into the relevant
step.

Identifying outcomes for different departments in your organization

6. Put the different departments in your organization in as steps and go through and link them to
the outcomes they are focused on. If you need several slices to do this, use clones so that
departments appearing on only one slice can still link to outcomes on the different slices in your
outcomes model.  

If you wish, you can then click on the step representing an individual department and print as
PDF all the slices in your outcomes model. This will give you a PDF on which the outcomes the
particular department contributes to are highlighted with their is a result of link icon showing. Print
out the PDF file for the department and put it on the wall in the relevant Department to represent
the outcomes it should be focusing on. This is a very visual way of showing staff in each
Department how they contribute to the overall outcomes of your organization. 

Tip: Remember because of DoView's flexibility more than one Department can contribute to a
single outcome (through linking).

* Strengths, Weaknesses, Opportunities and Threats analyses used in strategic planning.

4.4 Outcomes model
DoView is designed to help you build large or small outcomes models fast. Outcomes model go
by different names including: program logics, intervention logics, program theories, theories of
change, results chains, strategy maps, cause-effect models, etc.  The name 'outcomes model' is
a generic term for any representation that shows the causes and effects that lead to high level
outcomes. Once you have built your outcomes model for your project, organization, collaboration,
joint-venture or sector, you can use it as the basis for many areas of organizational life. See the 
What is DoView Section for a brief discussion of the DoView approach. 

To build an outcomes model:

1. Identify the high level outcome or outcomes you want to achieve and enter them as steps
along the top of a DoView slice. (It is a convention in DoView to put your high level outcomes
at the top of an outcomes model and the steps needed to achieve them below them).

2. Progressively put in the lower level outcomes that need to be achieved in order to make higher
level outcomes happen. If you need more than one slice, drill-down to lower level slices with
more detail about particular steps. 

3. Put in links between lower level outcomes and the outcomes above them which they make
happen (in those cases where it is not visually clear which steps lead to which or where you
want to store additional information (e.g. evidence) about the links). (See the Record Table
Section.

4. In larger models, containing many slices, you can make links between outcomes on different
slices.  You can link the outcomes (let's call them Outcome A and Outcome B) in this way by
doing the following: copy Outcome A (Right-click>Copy); move to the other slice where Outcome
B appears; clone (Right-click>Paste as C lone) Outcome A onto the second slice; link Outcome A
to  Outcome B; and, if you like, delete Outcome A's clone from the slice on which Outcome B
appears. From now on, if you click on Outcome A and move, without unselecting Outcome A,
to the slice on which Outcome B is located, you will see that Outcome B has its link icon
highlighted because it is linked to Outcome A.

5. Enter any additional information you have into the record table in rows associated with steps or
links in your model.
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Adding indicators and questions:

If you want to, you can add indicators or questions (e.g. evaluation or research questions) and
place them on a slice near by the outcomes they apply to. For more information on using DoView
to produce an evaluation plan see the Evaluation Plan Section.

The example below shows an outcomes model for the Green Houses - an Environmentally
Sustainable Houses Project. Normally, in DoView, an outcomes model would take up a number of
slices. Lower level outcomes within the model can be linked to higher level outcomes and
indicators and research or evaluation questions can be mapped onto the model. Additional
information can be put in regarding steps (outcomes), links, indicators and questions using the
rows in the record table associated with these objects.

4.5 Program logic
A program logic is a type of outcomes model which usually divides the elements in a model up
into a set of levels. These may include: outcomes, goals, missions, intermediate outcomes,
outputs, activities, tasks, drivers, key drivers, causes, effects, priorities etc.

So as to provide the most generic approach possible, DoView refers to all of these as just steps.
They are all steps in causal processes leading from the initial steps right through to the final
outcomes (outcomes are also just entered as steps) which are the end result of the causal
process.

If you want to structure your outcomes model, a traditional program logic such as one which has
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four levels -  inputs, outputs, intermediate outcomes and final outcomes - can be drawn in
DoView. This is done by putting all levels in as steps and differentiating between the levels using
rule lines between the steps and labeling the layers (using the text object). 

4.6 Strategy map
Strategy maps are another type of outcomes model developed by Kaplan and Norton*. Strategy
maps are usually structured into the four levels used in Kaplan and Norton's Balanced Score Card
approach.

The example below shows part of a strategy map for a Green House - Environmentally
Sustainable Houses Program. It has been divided into four levels which have been entered as 
text objects (the text has been resized as large) with rule lines between them. The elements in
the strategy map have been entered as steps. The bottom right green step has been selected and
so you can see the links between this and two other steps in the strategy map in the 'Customer
perspective' layer. If the user wished, they could enter information under such links in the strategy
map into the record table row associated with the link.
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* Kaplan, R.S. & D. P. Norton (2004) Strategy maps. Boston: Harvard Business School Press.

4.7 Evaluation & monitoring plan
DoView is ideal for building evaluation or monitoring plans.

To build an evaluation plan

1. Draw an outcomes model using the method described in the Examples of Use: Outcomes
Model Section.
2. Identify any indicators (measures of an outcome) you can and put them onto the model near
the outcomes they measure.
3. Identify any evaluation questions you can and put them onto the model near the outcomes they
measure.
4. Identify possible or actual evaluation projects and put them onto another slice in your model
using items to represent them.
5. Clone evaluation questions and copy them onto the evaluation project slice under the
evaluation project which will answer them. 

A small project plan for each evaluation project

6. If you wish, you can also use DoView to build a simple project plan for each actual evaluation
project you are planning to undertake.

The first example slice below shows an outcomes model for Green Houses - an Environmental
Sustainable Houses Program. Indicators and evaluation questions have been entered onto the
slice close to the outcomes which they apply to. 

Tip: Note that the causal links between the dark blue outcomes are being displayed because the
lower outcome has been selected. Details of previous research about the link between these
outcomes could be entered into the row in the record table associated with this link.
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The second example slice below shows the list of indicators which are being collected as part of
program monitoring. These have been copied from the slice above and pasted as clones (Right-
click>Paste as C lone) onto this slice.

Tip: Indicators are entered as small font. Their size has been increased here to medium sized
font (Right-click>Change Size>Medium).

The third example slice below shows evaluation projects and the evaluation questions the
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projects (entered as items) they will answer.  The evaluation questions have been copied from
the first slice above, cloned onto this slice and positioned under the evaluation project which will
answer them.

Tip: The notes field of the evaluation project items' row in the record table has been displayed on
the slice (Right-click>Show Details>Notes). Only one field from an object's row can be displayed at a
time on a slice and only certain objects (items, indicators, questions) can have fields displayed on
a slice in this way.

The fourth example slice below sets out a very simple project plan for one of the evaluation
projects.

Tip: There are great advantages in having all this information about your monitoring and
evaluation plans in a single DoView model. When you are using it in a meeting (DoView has been
optimized for use in meetings with a data projector) you will find that you are just a click away
from answering in a clear visual format all of the questions that may be raised by stakeholders.



68 DoView Help

© 2007-2008 The Ideas Web Ltd

4.8 Stakeholder plan
DoView can be used to visualize where stakeholders stand on the dimensions of influence and
level of support when this type of analysis is used in strategic planning. See the Examples of
Use: Strategic Plan Section on how to use DoView to build a strategic plan.

In the example below, stakeholders have been entered as items onto a slice. Additional
information about a particular stakeholder can be entered into the row of the record table
associated with the item which represents the stakeholder.

In a strategic planning meeting, stakeholders can be dragged around the slice to the point which
best shows where it is believed they are positioned in terms of influence and level of support.
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4.9 SWOT analysis
DoView can be used to do a SWOT (Strengths, Weaknesses, Opportunities, Threats) analysis as
part of strategic planning. See the Examples of Use: Strategic Plan Section on how to use
DoView to build a strategic plan

In the screenshot below, the headings for Strengths, Weaknesses, Opportunities and Threats
have been put on a slice as text objects with large text size (Right-click>Change Size>Large). Under
each heading, items have been used to put the Strength, Weakness, Opportunity or Threat onto
the slice.
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The second stage of a SWOT analysis tries to identify strategies which are able to address the
four possible combinations of strengths, weaknesses, threats and opportunities. DoView can be
used to model this as in the screenshot below. The items from the slice with the SWOT analysis
above have been cloned onto another slice, their size has been reduced to small (Right-
click>Change Size>Small). The strategies have been entered as items.

Tip: If there were a lot of Strengths, Weaknesses, Opportunities or Threats, one slice could be
used for each of the four possible combinations of Strengths, Weaknesses, Opportunities and
Threats.



Part

V

Building outcomes models



72 DoView Help

© 2007-2008 The Ideas Web Ltd

5 Building outcomes models
This sections sets out information about building outcomes models. It goes beyond the rest of the
information in this Help Documentation  which is about the technical aspects of using DoView as
a piece of software. The suggestions in this section apply to any outcomes models you build
regardless of whether or not you use DoView to build them.

Different people have different approaches to building outcomes models. Some have rules about
what you can and can not put into outcomes models. DoView is flexible enough to be able to
accommodate almost any approach you may wish to use, or which you may be required by others
to use.  

However, having built many outcomes models in many different areas, at DoView we have a
number of suggestions abut how to make your models better and these are set out in this section.

• Building good outcomes models - a set of guidelines for creating well constructed outcomes
models which can be used for many purposes (strategic planning, priority setting, monitoring,
evaluation, research and development planning, contracting and other aspects of
organizational life).

• DoView model conventions - some suggestions for conventions to use when building DoView
models.

• Why you should use compact slices - the advantages of building your models in compact slices
even if you also clone them to one or more large slices for printing to ledger/A3.

• What is an outcomes model? - why DoView keeps things simple by referring to all elements in
an outcomes model simply as outcomes at various levels rather than requiring you to have
work out exactly what type of element you are dealing with (e.g. goals, missions, intermediate
outcomes, outputs, activities etc.)

• Non-siloed outcomes models - explaining why it is an important feature of DoView that it lets
you link any outcome to any other outcome and it lets you clone outcomes, which avoids you
being forced to just drill down in single 'silos' under individual high level outcomes as happens
with some other software and database approaches.

• Typical DoView process - summary of the process of meetings etc typically used when building
a DoView outcomes model.

• Using DoView in meetings -  how to optimize using DoView in meetings.
• Workflow - Many projects within an organization - discussed how to work in a situation where

you are dealing with multiple projects which are all contributing to one set of high-level
outcomes.

• Workflow - OutcomesModels.org - models you can use - a set of outcomes models you can use
is available at www.outcomesmodels.org

5.1 Building good outcomes models
DoView is flexible enough for you to build your outcomes models any way you, or those you work
for, want you to. However, to get the most out of the outcomes models you build in DoView (or in
other software for that matter) you might like to look at the guidelines for drawing outcomes
models set out below. In particular, if you draw your outcomes models in this way you will find
that they can be used for a broad range of purposes. Some other ways of drawing outcomes
models, for instance those that demand that you only include outcomes which you can currently
absolutely prove you changed, leads to very limited outcomes models.  Such models may be
able to be used for accountability but are not much good for other purposes such as helping you
think strategically about other things you could do or about what you can and what you cannot
evaluate in terms of outcomes. A well built DoView model should be able to help you with
strategic planning, priority setting, monitoring, evaluation, research and development planning,
contracting and other aspects of organizational life.

http://www.outcomesmodels.org
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Guidelines* for drawing good outcomes models are:
1. Use outcomes not activities as your step names. You can change an activity (doing) into an
outcome (done) by just changing the wording (e.g. 'Increasing stakeholder support' to 'Increased
stakeholder support').

2. Let your outcomes models include any of the 'cascading set of causes in the real world'. In
DoView we just refer to every type of cause at whatever level as an outcome. See the What is an
Outcomes Model? Section for the reasons why. The steps that are put into your models do not
have to be limited just to your measurable, attributable (ones you can absolutely prove you
changed) or accountable outcomes. There is usually a lot of resistance to putting in your
outcomes models non-measurable and non-attributable outcomes. This is because stakeholders
want to manage their risk around being held to account for the outcomes that go into such
models. This is a genuine risk but is best managed by dealing with measurement, attribution and
accountability after your have built your base model. For instance, by dealing with measurement
by putting indicators onto your model (doing it this way lets you see which outcomes you do not
yet have indicators for); by dealing with attribution by going through later and marking those steps
which are attributable to a particular player (you could do this with color, brief letter codes, or put
the player in as a step and making links between them and all of their attributable indicators); and
by dealing with accountability by also going through later and marking those steps for which a
particular player is going to  be held to account (or contracted to do).

3. If you are not required to by others, do not force your outcomes model into particular horizontal
'levels' within the model such as inputs, outputs, intermediate outcomes and final outcomes. It is
possible to do this in DoView if you want to (e.g. see program logic and strategy maps), however
in some cases it may distort a good clear visualization of the flow of causality in the real world.
For instance, some types of outputs (for instance) may reach further up one side of an outcomes
model than another. Forcing artificial horizontal layers onto an outcomes model often distorts it
and makes it harder for stakeholders to ‘read’ the logical flow of causality in the model. The
concept of outputs is useful for accountability purposes and they can be identified later at
whatever level of a model they are located by going through and marking them with color or brief
letter codes. 

4. Do not 'siloize' your model. Silozing is when you draw an outcomes model in a way that
artificially forces lower level outcomes to only contribute to single separate high-level outcomes.
In the real world, good lower level outcomes can contribute to multiple high-level outcomes. Any
outcome can potentially contribute to any other outcome in a model, the way you draw the model
should allow for this. In contrast to may other software visualization and database approaches
DoView never forces you to siloize your outcomes model. Any outcome (step) can be connected
to any other outcome at any level through using linking.

5. Use 'singular' not 'composite' outcomes. Composite outcomes contain both a cause and an
effect (e.g. increase seat-belt use through tougher laws). This should be stated as two, rather than
just one outcome. Words like through, or by in an outcome show that you are looking at a
composite, rather than a singular outcome. 

6. Keep outcomes short. Outcomes models with wordy outcomes are hard to read. To help you
do this, DoView lets you include separate descriptive notes in rows within the record table where
you can put as much detail as you like about any outcome (step).  

7. Put outcomes into an hierarchical order. The normal DoView convention is to have highest
level outcomes at the top and then drill down to lower level outcomes. Use the simple rule that
you can tell that outcome A is above outcome B in a case where, if you could magically make A
happen, you would not bother with trying to make B happen. 

8. Each level in an outcomes model should include all the relevant steps needed to achieve the
outcome(s) above it. 



74 DoView Help

© 2007-2008 The Ideas Web Ltd

9. Keep measurements/indicators separate from the outcomes they are attempting to measure.
Measurement should not be allowed to dominate an outcomes model. If it does you are drawing a
model of what you can measure, not what you want to do. Using DoView measurement can be
introduced at a later stage by putting indicators onto a slice. In those relatively small number of
cases where a measurement also acts as an intervention in its own right (e.g. some audit
procedures), then it can be included as an outcome (step) within a model. 

10. Put a 'value' in front of your outcome (e.g. suitable, sufficient, adequate). You do not need to
define this at the time you first build your outcomes model. If it is not clear exactly what it
amounts to, it can become the subject of an evaluation project later on. 

11. Develop as many outcome slices as you need (but no more). In an outcomes model you are
trying to communicate to yourselves and to other stakeholders the nature of the world in which
you are trying to intervene. Slices can be seen as a series of cuts through the world of outcomes
in your area of interest. For instance you might have slices at the national, locality, organization
and individual level. The trick is to get the smallest number of slices needed to effectively
communicate the relevant outcomes in the model. DoView lets you quickly move through your
slices once you have built them with hop-to hyperlinks.

12. Do not assume that you need a single high-level outcome at the top of an integrated
organizational outcomes model. Outcomes models should be about the external world, not just
about your organization. Often organizations are delegated to undertake interventions in a
number of areas or sectors that are best modeled separately. If you build separate models for the
conceptually different areas or sectors you are intervening in, you can then just take that specific
model and use it in discussions with stakeholders from that sector. This keeps things really clear
for external stakeholders as the specific outcomes model which they are interested in is not
enmeshed with other outcomes from other sectors they are not interested in. In addition, if you
have drawn your models as generic 'cascading sets of causes in the real world' as suggested in 2
above, rather than restricting them only to outcomes which are attributable (ones you can
absolutely prove just you changed) to you, you will find that they make a lot more sense to
external stakeholders. External stakeholders can then just map onto the outcomes model the
particular outcomes they are focusing on.

13. Include both current high-priority and lower priority outcomes. Your outcomes model should
be as accurate a model as you can draw of the ‘cascading set of causes in the real world’
therefore it is not just about the current priorities you can afford to work on if they are a sub-set of
the wider outcomes picture. Once you have drawn your outcomes model you can then map a
typically more limited number of priorities onto your more comprehensive outcomes model. This
allows you to think strategically about alternative options in the future and reflect this by changing
your priorities. If your outcomes model only includes your current priorities it gives you no steer
as to how your current priorities map onto the real world. In a public sector context this also
allows outcomes models to support public sector employees providing ‘free and frank advice’
about how the world is – i.e. the cascading set of causes in the real world. It is also consistent
with the idea of evidence-based practice. It is then up to elected government officials to decide
what their priorities will be and these can be mapped onto the underlying outcomes model. This
approach means that outcomes models do not have to change every time there is a change in
the elected official in charge or of the government as a whole. If elected official priorities change
they are simply mapped onto the more comprehensive outcomes model. 

* These guidelines are an adaptation of the set of outcomes model standards which has been developed Duignan, P. (2006)
Outcomes model standards for Systematic Outcomes Analysis [http://www.parkerduignan.com/oiiwa/toolkit/standards1.html].
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5.2 DoView model conventions
Outcomes models can be visualized in different ways..Some suggested visual conventions for
drawing outcomes models in DoView are set out below:

• Put your highest level outcomes at the top of a slice and lower level outcomes below them.
This is consistent with outcomes orientated thinking because it makes the high level outcomes
the most prominent part of the model. It is also convenient because you usually have more
lower level outcomes in a model than high level ones and these can spread out over more than
one slice, using drill down below a high level slice containing your high level outcomes. You
can put a text object (small sized test) at the top left of the model saying Read from bottom to
top to help readers quickly grasp the way you have set out your model.

• For outcomes that affect many levels of other outcomes, put them down one side of the model
by rotating them.

• Do not put measurements (indicators) in as steps within your outcomes models, put
measurements in as indicators.

• Use colors to help readers understand an outcomes model.
• Use positioning of outcomes to visually show causality.
• Use different slices to show outcomes which are conceptually connected, for instance, have a

slice for national, locality, organizational and individual level.
• Put the date and version number in small text at the bottom right of your slice.
• Make an overall outcomes model and have specific slices drilling down from it (e.g. national,

locality etc.). Make these drill down slices sub-slices (drag them under the overall slice in the 
slice list) of the overall slice.  

5.3 Why you should use compact slices
DoView lets you use compact or large slices. See the Section on Slices for more information. 

There are a number of advantages in using compact slices. If you build a model using compact
slices you can, if you wish, also clone all of it onto one or more large slices so that you can print it
out on ledger or A3 paper. See the Section on Clones for more information. 

The advantages of using compact slices are as follows:

• Compact slices can always be viewed on a dataprojector. The philosophy behind the DoView
approach is to build a comprehensive outcomes model (program logic, strategy map, results
chain etc) which can be used for integrating all aspects of organizational or project life -
strategic planning, monitoring, evaluation, contracting etc. This means that the model needs to
be able to be used in all important meetings and amended in real-time in such meetings.
Printed ledger and A3 versions (large sized DoView slices), while they have the advantage of
being able to include more information, do not enable you to amend the model in real-time
(apart from notating minor amendments on the printed version). 

• Breaking your model up into compact slices encourages a modular approach to outcomes
model (program logic etc) development. Such a modular approach breaks an outcomes model
up into slices such as a  national,  local, institutional, individual etc level. This approach
increases efficiency because you can borrow modules from other outcomes models which you
can then amend and fit into the model you are working on. Once you have built your outcomes
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model you can then take modules from it and you, or others, can use them in subsequent
models in the future. Models from which you can borrow some or all slices are available at 
www.outcomesmodels.org.

• Compact slices can be emailed to anyone and viewed either on screen or printed as either a
PDF produced by DoView (See Section on Printing as PDF file) or as a DoView file for those
who already  have DoView or who want to download the DoView 14-day free trial. Outcomes
models just in ledger or A3 format, when emailed to someone who does not have access to a
ledger or A3 printer, can be hard for them to read on their computer screen. Being able to
share outcomes models with all of your colleagues is another aspect of the DoView approach.

5.4 What is an outcomes model?
An outcomes model is simply the 'cascading set of causes in the real world' which lie behind any
outcome happening. 

A range of different terms are used in strategic planning, project planning, program logic and
outcomes models for the elements which can go in these models: These terms include:
outcomes, goals, missions, intermediate outcomes, strategies, outputs, activities, tasks, drivers,
key drivers, causes, effects, priorities etc.

Many type of strategic planning software hard-wire these terms into their structure. As a result,
many normal users spend a lot of time trying to work out whether something is an activity or an
intermediate outcome, or an output or a whatever.

The DoView approach is to keep it all very simple and is based on the belief that all we are
talking about here is a set of things causing other things. At the top we have some outcomes and
all of their causes, from those at the very bottom, which make them happen. To keep it really
simple, DoView just calls all of these outcomes, at whatever level they sit in a model. 

The technical reason for calling them all outcomes is that the distinction between an outcome and
other levels of causes is often a relative one. An outcome for one organization may be a strategy
for another organization. The DoView approach is to draw outcomes models which are about the
real world, not just about organizations. This makes such models much more useful for a wide
variety of purposes. Making hard and fast distinctions between, for instance, outcomes and
strategies, or outcomes and activities, means that you are drawing the outcomes model from the
point of view of a single player when it may be better to have a more open and generic outcomes
model which reflects the issue you are working with in the outside world.

There is no reason why, after you have built a DoView model, you can not go through the model
and identify elements in it for particular purposes. For instance you might want to go through and
identify all those which are outputs for a particular player (color them, or put a text code in them,
or link the particular player to them). (Outputs are easily measurable actions that players take and
which they are held to account for doing).

5.5 Non-silioed outcomes models
DoView lets you build 'non-silioed' outcomes models. Have you have ever been frustrated
working with a strategic planning or other outcomes system which forced you to enter an activity
or task under just a single higher level outcome? If so, you were up against a system which
demanded a 'silioed' approach. 

http://www.outcomesmodels.org
http://www.doview.com
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The purpose of building good outcomes models is to try to realistically model the pattern of
causes and effects in the real world which lie behind your project, program, policy, organization,
joint-venture or sector. Software or database approaches which force you to build a 'silioed'
model force you to distort the reality you are working with. Users often have to respond to such
artificial restrictions by putting in the same, or sometimes differently worded, but similar, lower
level outcomes under a number of the higher level outcome silios. This is inefficient and creates
confusion for those viewing the model.

In contrast, DoView lets you link any lower level outcome to any number of higher level outcomes
within a model and so lets you create non-silioed more realistic models. When your models
include more than one slice (which is often the case) DoView lets you place clones ('live copies')
of any of your outcomes on any slice. When it comes to updating an outcome, the name, row in
the record table and links of any clones of the outcome you are updating are all updated
automatically right across the model.

5.6 Typical DoView process
This section sets out a few suggestions about the process of working with a group or organization
in building an outcomes model using DoView. These suggestions come from building a large
number of models for different organizations using DoView.

A typical DoView outcomes model building process can go as follows:

• Meet with those commissioning the work and tailor the following process to the particular
program, organization or sector.

• Meet with a wider group of stakeholders and explain how the process is going to roll out. Show
some examples of DoView models. Get initial input on the process. Discuss the DoView
suggestions for building good outcomes models (See Building Good Outcomes Models
Section). (Say a 1-2 hour meeting).

• Work with a smaller group to build the initial draft of the outcomes model. Have in the room the
highest level stakeholder you can, one person who knows how to work DoView and draw
DoView models. Several people who are subject experts. Try to keep this group reasonably
small. (Say four 3 hour meetings). Get participants to bring to the meeting any documents
which set out outcomes of any type or the program, organization or sector. Building outcomes
models can be rather intense work so 3 to 3 1/2 hours is usually about the right length of time.

• Take the draft model back to the wider group of stakeholders. Make sure the members of the
smaller group attend this stakeholder meeting (they will be able to explain some of the
decisions which have been made in building the draft model).

• Reconvene the small group to look at the feedback regarding the model and to amend the
model as appropriate.

• If appropriate, start work on identifying indicators and evaluation questions if this is part of what
you are planning to do.

• Appoint someone to be the 'Keeper of the model' who will keep it up to date and maintain it
over time. They can keep the Master copy of the model and send out copies for others to look
at and use in DoView on their own computers.

• Have the small group reconvene from time to time to make sure that the model is still up to
date.

Remember

• There are usually a number of good ways of drawing a DoView model. You do not have to get
THE right way of drawing the model, just one of the good ways of drawing it.
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• There are 'lumpers' and 'splitters' in the world. Lumpers will want to lump outcomes together
and splitters will want to divide them up into smaller and smaller outcomes. Generally let the
splitters do a little more splitting at the start of the process because you can always lump
outcomes together later on.

5.7 Using DoView in meetings
The DoView approach is that a comprehensive electronic version of an outcomes model (strategy
map etc) should lie at the center of all program and organization life. The same basic outcomes
model should be used for strategic planning, priority setting, monitoring, evaluation, reporting,
research and development planning, contracting and other aspects of organization life. Such
models need to be well constructed and they should be visualized in software in such a way that
they can be used in real-time during any important program or organizational meetings.

Users often build large outcomes models with other types of software which they can read at the
resolutions normally used on desktop PCs or when printed out on large pages (such as ledger/
A3). Such models can be built in DoView (from Version 1.1 if the user wishes). However, when
such models are used in a meeting with a data projector, meeting participants often cannot read
the detail in the models. This happens because of the combination of data projectors' resolution
(often 1024x768) and the physical size of the typical data projector screen which is used.

DoView has been designed to make sure that, as far as possible, all the details of any DoView
model (when built using compact slices) are clearly viewable when used with a data projector at
1024x768 resolution on a typically-sized physical data projector screen in a medium sized
meeting room. (See the Section on Why You Should Use Compact Slices for more information,
and note that you can clone a copy of your model made in compact slices to a larger ledger/A3
slice for printing if you wish).

This enables the electronic version (rather than just paper printouts) of a DoView model to be
studied and amended in real-time within a meeting. If the screen is too small in a very large
conference room then the model will not be able to be viewed properly.

If using DoView with a data projector you should check that the data projector is set at a
1024x768 resolution. This will make sure that the details of the model as large as they can be on
a data projector screen.

5.8 Workflow - Many projects within an organization
If you have many projects within one one program or organization your workflow for using
DoView could be as follows:

1. High-level outcome diagrams (slices) 
A set of high level outcome diagrams (slices) could be build by senior management and those
doing strategic planning (let's call them the Strategic Planners for the sake of the discussion here)
for your overall program or organization. In addition to the high level outcomes diagrams (slices)
in this model, there should also be a diagram (slice) listing all of the projects within the program
or organization. The project names can just be entered as steps (you may like to put '(P)' in front
of them so you can recognize them as steps later on. You can fit thirty or so of these onto a
single compact diagram (slice) and can include more than one slice if you have more than thirty
projects. This Program or Organization-Wide High-Level Outcomes model should be held and
maintained in a single DoView file by one person in management or planning (e.g the Strategic
Planner). You should think of it as being like a software spreadsheet, there needs to be someone
who holds the master copy to make sure that it is kept up-to-date and maintains its integrity. This
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Program or Organization-Wide High-Level Outcomes model can be turned into a web page
model (F ile>C reate W eb Page Model) and put up on your organization's intranet or on the internet
(see Section: Web page models (creating).

2. Individual project DoView models 
Each project team then develops its own DoView model which just contains diagrams (slices) at
the project level (typically this might be 4 or so slices - perhaps more). The model for each
project can be held in separate DoView files. This file should be held and maintained by someone
in the individual project team - let's call them the Project Team DoView File Holder. Each project
outcomes model can be turned into a web page model (F ile>C reate W eb Page Model) and put up on
your organization's intranet or on the internet (see Section: Web page models (creating).

3. Linking projects to high-level outcomes
When thinking about the high level program or organization-wide outcomes each project is
contributing to, these should be mapped onto the Program or Organization-Wide High Level
Outcomes model. This can be done in various ways. The first option is for the Strategic Planner
to meet with each project team and in such meetings link the particular project to high level
outcomes within the DoView file held by the Strategic Planner (1). This approach has the
advantage that the Strategic Planner can query the project team to make sure that they they are
only showing links to high-level outcomes which can be justified. The second option, is for the
Strategic Planner to create a web page model which they can put on the organization's intranet or
the internet. If there are a number of steps and outcomes, they could be numbered  and the
individual project teams would just need to let the Strategic Planner know which steps and
outcomes their project is aiming to influence.  A third option is for the Strategic Planner to just
email project teams a PDF file of the Program or Organization-Wide High Level Outcomes model
(DoView has built in support for printing to PDF), they could print it out and simply mark with pen
those outcomes in the model their project is contributing to. They could then fax or post this
marked-up printout to the Strategic Planner who could then enter it into the master copy of the
DoView file which contains the Program or Organization-Wide High Level Outcomes model. The
fourth option is for the Strategic Planner to email out the Program or Organization-Wide High
Level Outcomes model to someone in the project team who is familiar with using DoView and get
them to put in the links (e.g. the project team DoView file holder) as long as they are confident
that they will not introduce mistakes into the master file.

Once the Strategic Planner has the master file, with the programs linked to high-level outcomes,
they could record in each step box for each high level outcome the number of projects which link
to it. This provides a visual way of seeing how program or organizational projects map onto high
level outcomes. If they have put '(P)' in front of each project, when they do a right-click on an
outcome and select This is the result of they will be able to see the list of all project which it is
believed will influence this outcome. This approach can be used when doing strategic planning to
identify outcome areas which few,  or no, projects may be aimed at. 

4. At any stage either the Strategic Planner or the Project Team DoView File Holder can circulate
copies of their DoView file to anyone else (e.g. because some other part of the organization
wants to see how they have laid out steps and outcomes for a particular project). However, these
would always just be copies of the master file and it should be made clear to everyone that the
Strategic Planner or the individual Project Team DoView File Holders are the ones who hold the
master copies of the files. Any amendments which have to be made to these files would all go
through either the Strategic Planner or the individual Project Team DoView File Holders so as to
make sure that the master copies of the files are always kept up-to-date. One of the easiest and
safest ways of letting anyone get hold of a copy of a DoView file is to create a web page model
and select the option to include a copy of the original DoView file in the model and put the web
page model up on an intranet or the internet. Then for anyone who has DoView installed on their
computer all they need to do is click on the Download the DoV iew file of this model in the Option bar
at the bottom of the web page model and a copy of the file will open in DoView on their computer.
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[1] It is possible to do this remotely using an internet service which lets project team members view the
Strategic Planner's  screen showing them making the links on their copy of DoView in the course of a
conference call (one such service is called Glance - www.glance.net).

 

5.9 Workflow - OutcomesModel.org - models you can use
A range of outcomes models on different topics and from different sectors is available at www.
outcomesmodels.org.  They are available in both DoView file format and in PDF file format (for
anyone who does not have DoView yet). These are covered by a Creative Commons license
which means that you are free to use them for most commercial or non-commercial uses without
charge as long as you acknowledge their source. You can use then in the following two ways:

You can use them for ideas for outcomes models (program logics) you are drawing. The easiest
way, if you have DoView installed on your computer is to simply click on them on www.
outcomesmodels.org and they will open within your copy of DoView, then use this file to either
build your model or copy and paste whatever components of the model you want into the DoView
file in which you are building your model. 

http://www.outcomesmodels.org
http://www.outcomesmodels.org
http://www.outcomesmodels.org
http://www.outcomesmodels.org
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6 Installation and technical
This section provides installation and technical information as follows:

• Installing & uninstalling - information on installing and uninstalling DoView.
• Specifications - requirements of  computers running DoView.
• File formats & XML - information on file formats and XML.

6.1 Installing & unstalling
Installing

DoView can be installed by downloading the installation file from www.doview.com and running
through the steps in the standard installation procedure.  DoView can be run as a fully featured
demo program for 14 days from the date of download. It will then stop functioning. A license
registration key can be bought from www.doview.com for $39.95US.

Uninstalling

DoView is uninstalled by clicking on Start>A ll programs>Doview>Uninstall.

 

6.2 Specifications

DoView has been designed to run on machines meeting the following specifications:

• Operating system: PC's runing Windows 2000, XP, Vista
• Windows ME, 98 and below are not supported.
• Recommended speed: 600 MHz Pentium III with 128MB installed memory.

It is planned for a Mac version of DoView to be released in the future.

6.3 File formats & XML
DoView models (file) can be stored in any one of three formats. Files are saved in these formats
by selecting the Save as type option in the save dialog box when you save (F ile>Save) a DoView
model (file).

The three file types DoView can save in are: 

• DoView document - native DoView format - native DoView format, small file size, fast to load,
you should usually use this file type. The DoView file format was updated from Version 1.1
onwards to accomodate the new features introduced in Version 1.1 (line and arrow linking and
large ledger/A3 slices for printing). DoView 1.1 and later versions can read files made by earlier
versions of DoView but Version 1.04 and lower cannot read files saved by DoView Version 1.1

http://www.doview.com
http://www.doview.com
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and later. Updating to Version 1.1 from Version 1.04 is a free update for registered DoView
users.

• DoView XML* document - compressed XML format - XML format relatively small file size
(larger than the DoView document native format) (takes longer to load).

• DoView XML document (uncompressed) - uncompresed XML format - XML format relatively
large file size, you should use this file type if you want to move information between DoView
and some other software which you have customized to accept or produce files readable by
DoView. 

*XML is a standard for information interchange between different types of software. 

6.4 Support
Support for DoView is currently offered through the following:

• DoView Help - Main menu H elp>DoView H elp.
• Quick video tours - Main menu H elp>Quick V ideo Tours.

 

6.5 Buying DoView
Buying

DoView can be bought by going to www.doview.com.

Download DoView from www.doview.com and purchase a registration key (for $39-95US)* which
can be put into the downloaded version of DoView. The free trial version of DoView and the full
version are the same apart from the free trial version not running after 14 days. Corporate  
Corporate licenses for multiple licenses are available. See the DoView web site (www.doview.
com/buy.html).

Registration

Once you have been emailed your registration key (after you have purchased DoView from the 
www.doview.com site) you enter it by clicking on File>Register in the main menu, put in your
name or organization name and then put in the registration key.

* This is the current cost of DoView, cost may be subject to change at any stage.

http://www.doview.com
http://www.doview.com.
http://www.doview.com
http://www.doview.com/buy.html
http://www.doview.com/buy.html
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6.6 Troubleshooting
Troubleshooting

1. DoView will not open

Your 14-day free trial may have expired.

Solution: You need to purchase a registration serial number for US$39-95 from the DoView web
site and enter it when asked to do so when you attempt to run DoView.

2. DoView runs by cannot open a DoView file with DoView.

You may have an earlier version of Doview and are trying to open a file made by a later version.
For instance, if you have version 1.04 or below and try to open a file made by version 1.1 or
above you will get the following message: 'Cannot load file 'C:\FILENAME'. It requires at least
DoView version 1.1 to open'.

Solution: Get the updated version of DoView from www.doview.com.

3. Cannot draw lines and arrow links

Make sure that you have selected the Show links and draw lines option from the View menu (see the
Section on Views for Links and Lines for more information) and that you have also selected the
Insert L ink , and draw line mode for the Link tool on the toolbar (see the Section on Links and drawn
lines).

4. Making a copy of a slice

In early versions of DoView there was a Copy slice tool in the tool bar. This has been replaced by a
right-click on the slice name and selecting copy. 

http://www.doview.com/buy.html
http://www.doview.com/buy.html
http://www.doview.com
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linking with lines and arrows     23, 25, 27
links    

line and arrow arranging     27
line and arrow links     23, 25, 27
link icon     20, 23
link views     25

list of slices (diagrams)     18

- M -
main screen     10
measurement     35
meetings     78
merging models     43
model     44

conventions for drawing     75
making large models using drill-down     33
non-siloed     76

models    
building good models     72, 80

copying slices between     43
multiple open     45
rules for building     72, 80

modularity     75
monitoring plan (example)     65
move around view     33
mulltiple projects     78

- N -
navigation     32

between slices (hop-to)     32
non-silioed models     76

- O -
objects     16
open     17
organizations and DoView     78
outcomes model (example)     44, 62

building     72
building good models     72, 80
rules for building     72, 80

outcomes models    
terminology     76

- P -
page (slice)     15
pan     33
person     37
place     37
planning     61
printing     45
problems     84
program logic (example)     63
program theory (example)     62
project     37
project plan (example)    

assigning tasks     58
example     58

purchasing DoView     83

- Q -
question     36
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- R -
real-time use of DoView     78
record table     19

displaying fields on a slice     41
exporting data     41

redo     17
removing DoView     82, 83
replicant object     31
research question     36
resize     37
resolution    

screen     78
results chain (example)     62
rotate     40
row     38
rule line     35

- S -
saving     82
screen size     78
sharing models     47, 53
show details     41
slice    

compact slice     15
large slice     15

slice list     18
slice size     75
slice viewing area     10
slices    

compact     75
large     32, 33

small slice list tool bar     15
solutions to problems     84
specifications     82
stakeholder plan (example)     68
starting screen     10
step    

aligning     37
entering     20
rapid entry     20
resizing     37

strategic plan     61
strategy map (example)     64

Strengths, Weaknesses, Opportunities & Threats
analysis     69
SWOT analysis     69

- T -
table     19
terminology     76
text     34
Theory of Change (example)     62
thing     37
toolbar     17
tracking change     35
troubleshooting     84
turn on side    

object     40

- U -
undo     17
uninstalling     82, 83
URLs     56
using    

DoView in meetings     78
using DoView     78

- V -
Version 1.03 changes     8
vertical    

box     40
object     40
text     40

view     33
views     25
visualizing links     25, 27

- W -
web address     56
web page models     47, 53
websites - creating     47, 53
workflow    

many projects within an organization     78
working with DoView     78
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- X -
XML     82

- Z -
zoom     33

zoom to actual     32
zoom to fit     32
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